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Introducing Corel® Home Office

Corel® Home Office is a new office suite that’s ideal for the kind of work you do 
at home. Whether you’re doing the family budget, completing school work, 
preparing materials for volunteer projects, running a home-based business, or 
simply catching up on work from the office, this streamlined suite is just what 
you need.

As traditional office productivity software has evolved, the number of tools and 
options has grown steadily. Power users, particularly those in enterprise 
environments, require the high-end features and depth of control that can only 
be found in a mature, full-featured office suite. But there’s also a significant 
group of users who don’t need these extra features and the complex interface 
that comes with them. They want easy access to the essential tools they use 
every day. Besides, many home users would rather not pay for functionality they 
never use.

Software isn’t the only area where this kind of shift has occurred. Many people 
have changed their expectations for home PCs, too. Netbook adoption is having 
a dramatic impact on the computer hardware industry. People want affordable, 
portable computers that give them the core functionality they need — 
anywhere, anytime. 

Until now, netbook users had limited options for office software. Desktop office 
software was typically too resource-intensive and demanded too much memory 
space to run on these lower powered computers. While Web-based solutions 
offer basic functionality, if the wireless connection drops, users can’t access these 
tools at all.

Ideal for desktops, notebooks, and netbooks, Corel Home Office offers three 
applications that deliver the most-used tools for office productivity tasks. Corel® 
Write for word processing, Corel® Calculate for spreadsheets, and Corel® 
Show for presentations give you the features you need right at your fingertips.
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Corel Home Office has a fresh, sleek interface that puts the tools and features 
you use most front and center. This means that you’ll spend less time searching 
through menus and dialog boxes. With the ability to work with Microsoft® 
Office files, the power to create PDFs in all three applications, and multilingual 
Unicode support, compatibility is a cornerstone of the suite.

Built to take advantage of the power of desktop computing, Corel Home Office 
ensures that you always have the tools you need — even when you don’t have a 
Web connection. The software is also breaking new ground by shipping on a 
USB stick instead of a disk, making it easy to install on the go — even on a 
netbook that doesn’t have an optical drive. With a download of about 100 MB, 
Corel Home Office is easily installed on your computer. And once installed, it is a 
fraction of the size of Microsoft® programs like Office Home and Student (with 
an install size of approximately 1.5GB). With this small footprint, 
Corel Home Office won’t take up much space on your netbook, laptop, or 
desktop PC.

Corel Home Office brings the power of a desktop office suite to the netbook.

Customer profiles

Consumers: Consumers include anyone looking for an easy-to-use and 
affordable home office suite. These users may bring files home from the office 
and need a seamless workflow with the tools they use at work. They could be 
students who need an easy-to-use tool to create polished reports. They might 
also be community-minded people who volunteer their time to create 
newsletters, budgets, or slide shows that can be shared by e-mail or posted on 
the Web. 

Home-based entrepreneurs: Home-based business owners rely on office 
productivity tools to write proposals, track finances, create marketing 
presentations, and perform a variety of other tasks. They’ve worked with other 
office suites, so they’re familiar with an office suite environment. It’s critical that 
they're able to share documents with clients and suppliers, so they demand 
compatibility with standards like Microsoft Office and PDF.
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Features

Suite-wide

Application Launcher: The easy-to-use Launcher gives you convenient access 
to Corel Home Office applications and free product updates.

The Launcher lets you access Corel Home Office applications.

Give it a try
Launching applications

1 On your desktop, click the Corel Home Office icon .

2 Click one of the following:
• Start Corel Write

• Start Corel Calculate

• Start Corel Show
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Netbook ready: On a netbook, the Corel Home Office user interface 
automatically resizes to fit onscreen without compromising easy access to the 
tools you use the most. If you need even more room, pressing F11 hides the 
tabbed toolbar to maximize the workspace.

Corel Home Office automatically resizes on 
netbooks without compromising functionality.

Publish to PDF: Share documents, spreadsheets, and slide shows by publishing 
your work to PDF — without any extra software. All three applications in 
Corel Home Office let you easily publish to PDF, and you can e-mail them directly 
from the suite.

You can publish to PDF and e-mail from any Corel Home Office application.
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Work with the latest Microsoft Office formats: You can easily open and 
save Office Open XML (OOXML) files, ensuring that it’s easy to work with 
Microsoft Office 2007 formats. 

Collaborating with Microsoft Office 2003 users is also a snap with 
Corel Home Office. In all three applications, you can open and save as 
Microsoft Office 2003 files. You can even e-mail your work directly from a 
Corel Home Office application as a Microsoft Office 2003 file.

You can e-mail work as Microsoft Office 2007
files from any Corel Home Office application.

Give it a try
Publishing to PDF

1 Click the Quick Access icon in the top left corner of workspace.

• In Corel Write, click .

• In Corel Calculate, click .

• In Corel Show, click .

2 Click Save as  PDF Portable Document Format.

3 In the Print to PDF File dialog box, click Save.
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Customize the workspace: Whether you prefer the intuitive tabbed toolbar 
or the more traditional menu bar, Corel Home Office lets you choose the user 
interface that best suits how you work. Corel Home Office displays the tabbed 
toolbar by default. 

You can use the tabbed toolbar (top) or the traditional menu bar (bottom).

Give it a try
E-mailing documents as Microsoft Office 2007 files

1 Click the Office Button icon in the top left corner of workspace.

• In Corel Write, click .

• In Corel Calculate, click .

• In Corel Show, click .

2 Click Send as, and choose the Microsoft Office file format that 
corresponds with the Corel Home Office application.

Give it a try
Activating the menu bar

• In the top right corner of any Corel Home Office application, click 
Options  Toolbar Mode.
You must restart the application for the change to take effect.

You can switch back to tabbed toolbars by clicking Tools menu  
Customize, clicking the Options tab, and enabling the Tabbed 
Toolbar check box.



Reviewer’s Guide [ 7 ]

Change the toolbar color: You can select from one of four colors for the 
toolbar. 

You have a choice of toolbar colors.

Change languages on the fly: Users who live or work in multilingual 
environments will love the ability to quickly change languages. 
Corel Home Office lets you work in many languages without having to 
download language packs. MUI-compliancy means that Corel Home Office opens 
in the language of the operating system. What’s more, Unicode support in Corel 
Home Office lets you work with files created in an array of languages.

You can easily switch between a variety of languages.

Give it a try
Changing the toolbar color

• In the top right corner of any Corel Home Office application, click 
Options  Style, and choose one of the following toolbar colors:
• Blue
• Black
• Silver
• Aqua
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Access commands easily: The Quick Access toolbar puts the most frequently 
used commands together in one place. You can tailor the Quick Access toolbar to 
suit your style of working by adding any command found in a menu.

You can customize the Quick Access toolbar so that the 
commands you use the most are right at your fingertips.

Give it a try
Changing languages

• In the top right corner of any Corel Home Office application, click 
Options  Language, and choose one of the following options:

• Match OS Language (language used by the operating system)
• Dutch
• English
• French
• German
• Italian
• Spanish
• Swedish
• Simplified Chinese
• Traditional Chinese
• Korean
• Japanese
• Brazilian Portuguese

Give it a try
Adding commands to the Quick Access toolbar

1 Click the arrow to the right of the Quick Access toolbar, then click 
More Commands.

2 In the Customize dialog box, click Save As in the list of commands on 
the left.

3 Click Add.
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Corel® Write

Corel Write has everything you need to create and share a variety of documents, 
including reports, quotations, memos, mailings, and newsletters. 

Corel Write lets you quickly do the word processing tasks you perform most often.

Create labels, envelopes, and mail merges: As much as e-mail and the 
Web have changed the way we share our ideas and information, home-based 
businesses and families will always need tools for traditional mail. That’s why 
Corel Write gives you high-end tools for creating and printing labels and 
envelopes. And an easy-to-use mail merge feature simplifies mass mailings, 
whether it’s a promotional flyer to clients or the annual family newsletter for 
relatives and friends.

You can create labels, envelopes, and mass mailings.

Add tables of contents, indices, and footnotes:  Just because it’s a 
lighter office suite doesn’t make the documents you create with Corel Home 
Office any less important. To that end, Corel Write lets you easily add tables of 
contents, indices, and footnotes to reports, term papers, and proposals.

Turn text into designs: When you want to add a little spice to your 
documents, WriteFX helps you transform text into art. Ideal for creating logos, 
WriteFX includes a gallery of templates helps get you started. You can also 
create your own designs.

Give it a try
Creating text art

1 Click the Insert tab.

2 In the Illustrations area, click Write FX.

3 In the Corel Write FX dialog box, click through the tabs to select text 
customization options, and click OK.
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Corel® Calculate

Corel Calculate is the perfect tool for managing numbers — whether for a 
business account, home finances, complicated calculations, or homework. 

Corel Calculate gives you quick access to the spreadsheet tools you use most.

Get right to work: The Task Pane, located on the right side of the workspace, 
puts settings for the most common spreadsheet tasks front and center.

The Task Pane helps you get to work quickly.

Filter data easily: With intuitive data filtering and validating tools, you can 
sort spreadsheet cells to get a different view of their information.

You can sort data with easy-to-use tools. 

Create pivot tables: You can easily create pivot tables with the help of the 
Task Pane.
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Corel® Show

Corel Show takes the guesswork out of creating polished, easy-to-share slide 
shows.

Corel Show puts all the tools you need to create slide shows at your fingertips.

Get right to work: The Task Pane displays a gallery of slide templates that can 
help jump-start a slide show. Get right to work by choosing from a variety of 
predesigned slides, which you can be easily modify to suit your needs.

Save as PPT:  Microsoft® PowerPoint® (PPT) is the default format when you 
save a slide show. In addition, you can open Microsoft PowerPoint 2003 and 
2007 files.

Corel Show makes working with Microsoft Power Point files a snap.

Create consistency with master slides: A master slide consists of a set of 
predefined layouts and backgrounds that are used in every slide in a 
presentation. You can add a company or association logo, text, or image to 
polish slide shows.

Give it a try
Choosing a slide layout

1 Click the arrow in the Task Pane, and click Slide Design.

2 Click a layout icon in the Apply Slide Layout list.
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Minimum system requirements

• Windows Vista® Home Basic, Home Premium, Ultimate, and Business (32-bit 
and 64-bit) or Windows® XP Home, Media, or Professional Edition (with 
latest service pack and critical updates)

• 256 MB RAM on Windows XP; 512 MB RAM on Windows Vista

• 1 GHz processor

• 285 MB hard disk space for full installation of all included applications and 
languages

• 1024 x 768 screen resolution (768 x 1024 on a tablet PC)

• USB drive

• Mouse or tablet
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Sample workflows

Corel® Write

Compatibility is one of the cornerstones of Corel Home Office. In this workflow, 
you’ll create a flyer based on a DOCX file, import imagery, and create a PDF from 
the end result.

Give it a try
Creating a business flyer

1 On your desktop, click the Corel Home Office icon .

2 Click Start Corel Write.

3 Click the Open button , and navigate to the Reviewer’s Guide 
File folder on the Corel USB stick.

4 Select Flyer_Text.docx, and click Open.

Corel Write opens and saves DOC and DOCX files and ensures that all 
formatting is maintained.

5 To free up more of the workspace to view and design the flyer, click 
the View tab, and do the following: 

• Choose 75% from the Zoom Level box .

• Disable the Show/Hide Vertical Rulers, Show/Hide Horizontal 
Rulers, and Task Panes check boxes.

Corel Home Office automatically resizes tabbed toolbars for netbooks.

6 Now, you’ll insert a graphic as a banner for the flyer. Click the Insert 

tab, click the Picture button , navigate to the Reviewer’s Guide 

File folder, select Banner.jpg, and click Open.

7 Next, you’ll resize the banner. Click the image, and drag a corner to 
handle until the image is the same width as both text columns.

When you click an image file in any Corel Home Office application, the 
Drawing Tools toolbar displays automatically.



[ 14 ] Reviewer’s Guide

The completed business flyer

8 To wrap the text around the banner, click the Text Wrapping button 

, and choose Square.

9 Finally, you’ll publish the flyer to PDF. Click the Quick Access button 

, and click Save As  PDF Portable Document Format.

You can also e-mail the PDF directly from all Corel Home Office 
applications.

Give it a try
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Corel® Calculate

Like all Corel Home Office applications, Corel Calculate lets you open and save 
Microsoft Office 2007 files and publish to PDF — without having to purchase 
additional software. In this workflow, you’ll create an inventory report based on 
an XLSX file, add a logo graphic, and create a PDF.

The inventory report in Corel Calculate

Give it a try
Creating an inventory report

1 On your desktop, click the Corel Home Office icon .

2 Click Start Corel Calculate.

3 Click the Open button , and navigate to the Reviewer’s Guide 
File folder on the Corel USB stick.

4 Select Wine_List.xlsx, and click Open.

Corel Write opens and saves XLS and XLSX files and ensures that all 
formatting is maintained.

5 Now, you’ll add a total to the Sales column. Select cell 42H, click the 

Sum button , choose Sum, and press Enter.

6 Now, you’ll insert a logo to the inventory report. To make room for the 
graphic, increase the height of Row 1 to approximately 1.5 inches. 

7 Click the Insert tab, click the Picture button , navigate to the 
Reviewer’s Guide File folder, select Vines_Logo.jpg, and click 
Open.

8 Next, you’ll resize the logo. Click the image, and drag a corner to 
handle until the image is the same height as Row 1. Center the image 
within the existing columns.

9 To clean up the inventory report a little for printing, you’ll remove the 
header. Click the Page Layout tab, and click Format 
Header&Footer. In the Header and Footer dialog box, select &F, press 
Delete, and click OK.

10 Finally, you’ll publish the inventory list to PDF. Click the Quick Access 

button , and click Save As  PDF Portable Document Format.
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Corel® Show

Corel Show lets you create polished presentations. In this workflow, you’ll open 
a Microsoft PowerPoint file and add your own touches to create a self-running 
slide show.

The slide show 

Give it a try
Creating a self-running slide show

1 On your desktop, click the Corel Home Office icon .

2 Click Start Corel Show.

3 Click the Open button , and navigate to the Reviewer’s Guide 
File folder on the Corel USB stick.

4 Select Winery_Slideshow.ppt, and click Open.

Corel Show opens and saves PPT and PPTX files and ensures that all 
formatting is maintained.

5 Now, you’ll add a color scheme. Right-click the bottom-right corner of 
the slide, and click Color Scheme. In the Color Scheme dialog box, 
select the last color scheme, and click Apply All.

6 Next, you’ll add an image to slide. On the left of the workspace, select 
slide 3. Double-click Double click to add content, choose the 
Picture option, and click OK. Navigate to the Reviewer’s Guide File 
folder, select Winery.jpg, and click Open.

7 To choose a slide transition, click the Slide Show tab on the toolbar, 

and click the Dissolve button  in the Transition area.

8 Now, you’ll set the duration for each slide to 2 seconds , and 
click Apply To All.

9 Click the View Show button  to play the slide show.
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